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Introduction
The Internet has rapidly evolved into the next mass medium.  This explosive growth is
matched by an emerging wealth of online content.  Rapid technical innovations have enabled
the creation of more compelling content delivered over the web.

To take advantage of this growth, content providers must have the ability to reach the entire
Internet audience with the widest variety of information and entertainment.  Users
accustomed to traditional media will not tolerate delays caused by large downloads or
incompatible technologies.  Producers seeking to create the most compelling content cannot
be constrained by the type of media currently suitable for online use.

Macromedia Flash and RealAudio have come together to provide you with RealFlash,
streaming animation that is synchronized with RealAudio.  RealSystem 5.0 delivers:

  One Player/Plug-in For Animation, RealAudio, and RealVideo
With RealSystem 5.0, the end user can view animation and listen to audio with the
same player/plug-in/activeX control. There are also over 20,000,000 RealPlayers
already in place, ready to view your content.

  Flexible and Superior Audio
A wide range of audio Codecs are now available for content authors to make choices
regarding bandwidth and quality not previously available.

  Reliable Delivery
Guaranteed delivery of RealFlash presentations over the Internet at bit rates of 28.8
and higher.

  Real-time Streaming
Files play back on demand without download wait.  Synchronized RealAudio and
RealFlash presentations can stream effectively over 28.8 Internet connections.

  Improved User Experience
The user experience is significantly improved with functionality such as seeking,
pausing, or rewinding not available via HTTP pseudo streaming without download
waits.
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Overview
This guide will help you create a synchronized, streaming RealFlash and RealAudio
multimedia presentation and will assist you in authoring Flash content that is optimized for
use with RealSystem 5.0.

RealAuido and RealFlash Content Creation Guide is intended for people who are familiar
with the World Wide Web, RealNetworks technology, and Macromedia Flash Authoring
Tool. You do not need previous experience using RealEncoder or RealPublisher , but you do
need to know how to create directories or folders, copy files, and open text files.

Presentation Planning
Your initial planning requires you to develop and understand some basic questions:

• What do I want to create?

• Why is it being created?

• What is the message to be conveyed?

• Who is the audience for the presentation?

With RealAudio and RealFlash Animation, understanding the answers to these questions
will help you create the highest impact and most widely viewed presentations.

Note: It is important to read through the “Optimizing Animation” section of this guide
before you begin your presentation.

Reaching the Largest Audience
Every computer network connection has an upper limit or bottleneck on the amount of data
that can pass through it in a given second. This data limit is called bandwidth. The data rate
(also called “bit rate”) of a file is the amount of data that must transmit in a given second for
the whole file to be viewed and heard.

The majority of Internet users have 28.8K modems. Providing content that meets the
delivery needs of this target audience ensures the largest audience possible to view your
presentation. For 28.8K presentations, you should use an optimal total bit rate no greater
than 20 Kbps. For example:

20 Kbps total bit rate = 6.5 Kbps audio file + 13.5 Kbps animation file
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In a RealFlash/RealAudio animation, the data rate equals the sum of the audio bit rate and
the RealFlash bit rate.

Hardware Requirements
The minimum hardware requirements for presentations are computers equipped with at
least:

Minimum Hardware Requirements for Creating RealFlash
and RealAudio Presentations

Processor Intel Pentium 90 CPU or
equivalent MacPPC

Memory 16MB RAM

Components of RealSystem 5.0
To achieve the best results in streaming synchronized RealFlash and RealAudio files, we
strongly recommend using RealNetworks’ RealSystem 5.0. RealSystem 5.0 is an end-to-end
streaming media solution that is the most widely deployed and field-tested system for
delivering real-time animation, audio, and video over the Internet. RealSystem includes
Encoders, Servers, and Players.

Product Use Customer

Encoders Prepare audio and animation for
streaming; create files to put on server

Web developers and Internet audio and
animation producers

Servers Send data to players using protocols Corporations and Web developers who
want to broadcast audio and video

Players Play audio and animation streams End users
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RealAudio and RealFlash Files and
Metafiles
The RealSystem 5.0 uses several file types, each identified by a specific file extension. The
files and their file extensions are:

RealMedia clip (.rm) - Audio or video encoded to RealAudio and RealVideo formats. This
file is created with RealEncoder or RealPublisher and delivered by the RealServer
streaming media server. The .rm files can contain multiple streams, including audio, video,
image maps, and events. Video files can contain audio and video or video only and can be
played with RealPlayer.  Audio only files can be played by RealPlayer and RealAudio
Player.

RealMedia metafile (.ram) - The file that connects a Web page to one or more RealAudio
or RealFlash clips. The metafile is located on a Web server and is linked by a Web page.
The metafile contains the URL of one or more clips located on a RealServer streaming
media server.

RealPlayer Plug-in metafile (.rpm) - The same as a metafile, but used with RealPlayer
Plug-in for Netscape Navigator and Internet Explorer 3.0 and later.
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Delivering a RealAudio and RealFlash
Animation Clip
The following figure shows the process flow and components of The RealSystem used to
deliver a typical RealAudio and RealFlash Animation. The numbers in the figure match the
numbered steps following the figure.
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RealVideo Delivery System

1. The Web browser displays a Web page that contains a link to a metafile.

2. The user clicks the link. The Web browser requests the metafile from the Web Server.

3. The Web server delivers a metafile to the Web browser.

4. The Web browser starts RealPlayer as a helper application and passes it the metafile.
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5. RealPlayer reads the first URL from the metafile and requests it from RealServer.

6. RealServer begins streaming the requested presentation clip to RealPlayer.
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Creating RealFlash
You create RealFlash animation in Macromedia Flash much as you would when creating a
Shockwave Flash file for delivery by a Web server. You add audio tracks and synchronize
them to the animation layer, saving the file in the Flash Movie (.fla) format.

When your presentation is ready, though, you export two files. The first is a Shockwave
Flash video layer (the animation) without audio. The second is a video file (.avi) that
contains the audio track. You then use RealNetworks tools to distill the audio portion of this
video file into the RealAudio format. The resulting presentation comprises two files:

• Shockwave Flash file (.swf)—Created with Flash Authoring tool

• RealAudio file (.rm)—Created with Real Encoder or RealPublisher

Target and Total Bit Rate
When deciding the parameters to set for your RealFlash files and RealAudio files, consider
the total bit rate, which is the combined bit rate of the RealFlash and RealAudio files. The
following are the recommended total bit rates for common modem bandwidths.

Target Modems Total Bit Rate

28.8 Kbps 20 Kbps

56.0 Kbps 35 Kbps

64.0 Kbps 56 Kbps

128.0 Kbps 105 Kbps

As shown in the table above, the total bit rate is reduced by 25% to compensate for
connection and packet overhead that occurs during transmission. So if the target modem
speed is 28.8 Kbps, the total bit rate should be 20 Kbps.

Remember, 28.8K modems are by far the most common means of delivery on the Internet.
To reach the widest audience, therefore, keep the combined bandwidth of the Shockwave
RealFlash file and the RealAudio file to 20 Kbps or less.
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Exporting RealFlash and RealAudio Files
Follow the steps below to convert your Flash file (both animation and audio) into a RealFlash
presentation.

Exporting a Shockwave File

1. Open the Flash file (.fla) in Macromedia Flash.

2. Select File Export Movie.

3. In the dialog box, choose *.swf (Shockwave) as the file type.

4. Enter a file name that uses the .swf extension and click OK.

5. From the “Export Shockwave Flash” dialog box, set JPEG Quality between 30 and 50.
(You may have to export the file several times with different settings before finding the
best JPEG quality.)

6. From the “Audio Stream” and “Audio Event” drop-down boxes, choose Disable to turn
off the native Flash audio.

7. Click OK to create the Shockwave file, which consists of animation only. Leave the
Flash file open to export the audio as described in the next section.

Creating a RealAudio File

1. With your Flash file open, select File Export Movie.

2. In the dialog box, choose AVI (*.avi) as the file type.

3. Enter a file name that uses the .avi extension and click OK.

4. In the “Export Windows AVI” dialog box, select dimensions of 32x32 regardless of the
movie’s true dimensions. This minimizes file size and creation time.

5. Click OK to create the AVI file. Once the file is created, you can close the Flash
application.

6. Open Real Encoder or RealPublisher.

7. Choose File Open Session.

8. On the Source panel, click File, and add your AVI file to the list box. On the
Destination panel, click RealMedia and specify an output file name with the .rm
extension. Click OK.
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9. In the Templates panel, click Advanced and deselect video. Then select an audio
Codec. This tells Encoder/Publisher to save only the synchronized audio portion of the
AVI file.

10. Enter a template name and click Save. Then click Close.

11. In the Templates panel, click Start to create your audio file. You can then close
RealEncoder or Real Publisher.
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RealFlash and RealAudio Playback
There are two ways of using RealPlayer to play audio and animation files:

1. As a stand-alone player, launched from a link in a Web page.

2. Embedded in a Web page using our Active X and Netscape plug-in.

The first requires less design and allows you to deliver your presentation files using the
RealPlayer Helper Application. Embedding RealPlayer controls in a Web page offers
seamless multimedia presentation within your page.

To play both the .swf and .rm file back locally, you need to create a metafile. This metafile
has the extension, .ram and rpm for Netscape Plug-in and Active X controls. The function of
a .ram file is to tell the RealPlayer where both the .swf and .rm file are located.

To create a metafile:

1. Open Notepad (or a text editor of your choice).

2. Type the location of the .swf and .rm files.  Example:  file:c\temp\foo.swf+foo.rm

3. Save your file with a .ram extension in the same directory as your .swf and .rm files.
Example: foo.ram.

Note:  All file name and directory structures can follow long file name format. However,
directory and file names cannot contain spaces.

To play back your local files using RealPlayer 5.0:

1. Open up RealPlayer 5.0.

2. Under the File menu, choose Open File.

3. Select a metafile to open.

4. Click Open.

5. Your files will now be played back in RealPlayer.

To play back files located on a RealSystem Server:

1. Follow steps 1-5 for playing back local files in the RealPlayer 5.0, except replace file
file:c:\temp\foo.swf+foo.rm with pnm://servername.com/foo.swf+foo.rm.
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Performance Improvement Tips
There are several ways to optimize Flash files and audio files before converting them to
RealFlash and RealAudio.

Optimizing Flash Content before RealFlash
Conversion
1. Import all audio into Flash. Typically, each line of dialog is a unique sound file.

2. Lay sounds into the Flash timeline. Make sure sounds are placed as streaming sounds.

3. Add enough frames during and between sounds so that timing is correct.

4. Place images into the Flash movie, synching to the sound timeline you’ve just created.

5. In the Sound dialog box, set the Synchronization option to Stream. This will
synchronize the audio with the master timeline.

Files with Interactive Components
The Flash Play, Stop and GoTo actions correspond to the RealPlayer 5.0 play, pause and
seek commands. Interactivity is accomplished with seeks along the timeline.

Modifying File Bandwidth with swftune.exe
Swftune is a DOS command-line utility that lets you change the available bandwidth of a
RealFlash file delivering a smoother presentation with minimal spikes in bandwidth
consumption.

For example, if your .swf file is streaming at 9.5 Kbps and you are using a 6.5 Kbps audio
file, the presentation’s total bandwidth is 16 Kbps. If your bandwidth limit is 20 Kbps, you
can still use an additional 4 Kbps in your presentation. With swftune you can change the
stream rate of your 9.5 Kbps file to 13.5 Kbps. This lowers the amount of preroll that occurs
and minimizes the amount of buffering. As well, the amount of rebuffering that may occur
during playback will decrease.  This results If swftune is used to decrease the bitrate of a
Shockwave Flash file, then it will increase the amount of preroll that occurs at the beginning
of playback.
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To use swftune, First download the “optimization kit” available with the RealFlash Content
Creation Guide and extract the contents to your C:\Real directory. To run swftune, change
to you C:\Real directory and type in the appropiate flags listed below.

Usage: swftune [options] filename

   -b [ New Bitrate ]     Set the bitrate of the file
   -c                         Report characters size & info
   -d                         Report bandwidth usage info
   -o [ Filename ]         Output to a different Filename
   -u                         Write changes back to swf file

For Example, type in the following at the c:\Real:

swftune -b 13500 -o output.swf -u input.swf

The above example will change the bitrate input.swf, to 13.5 Kbps and write the changes to
output.swf.

• The -o flag allows you to specify a name for the output file.  If this flag is not used, then
input.swf will be overwritten.

 
• The -u flag must be used if you wish to write out the changes to the .swf file.  If the -u

flag is not used, then no changes will be written out to the file.
 
• The -c flag will print out a report to the screen detailing the size and character

information about the objects in the .swf file.
 
• The -d flag will print out a report to the screen detailing the bandwidth usage

information.

Optimizing Animation
Once files are converted into Shockwave, the files may still require optimization. A
RealFlash movie will play smoothly only if RealPlayer can receive data over the network at
about the rate the RealFlash movie is set to play in frames per second.
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Making your .swf file very low bit rate

• Simplify elements drawn in Flash or imported from other drawing applications.
Under the Modify menu, the Curves pop-up menu contains the Smooth, Straighten and
Optimize commands. The Smooth and Straighten commands automatically smooth or
straighten the currently selected lines and curves. Optimize allows you to control the
amount of smoothing and straightening of lines and curves, whether multiple passes
are used to accomplish the optimization. It also reports the amount of optimization that
has occurred with each pass. Use Optimize when you want to preserve as much of the
original appearance of the lines and curves as possible. The goal is to strip away
unneeded point and path information to reduce the amount of stored data to the
minimum required to render your object on the screen. Because screen resolution is
substantially lower than common print resolutions, minute details can often be
eliminated from the drawing without compromising the overall appearance.

• Use symbols instead of groups when you repeat elements.  Symbols are stored once
in the file and may be referenced many times, adding very little data to the file for each
reference to the original symbol. Groups are stored in the file every time they are used.
So, if you have a group of items that is used three times, you store the same data in the
file three times. If you use a symbol in this instance instead of a group, then you are
storing the data once and adding three very small references to that data in the file.
Ultimately, the advantage of using symbols instead of groups can reduce the size of
your movie file significantly.

• "Preload" symbols when too much data is needed all at once. As mentioned above,
RealFlash must have a symbol fully downloaded before it can render a frame that
contains it. Use the size report and a visual inspection of the movie to pinpoint areas
where performance begins to suffer because too much data is suddenly needed for a
frame. If your movie has smaller symbols, you can preload them by placing them on a
layer beneath an item that hides them from view. This technique can be used to load
some symbols ahead of time (while hiding them from view) so they are ready for use
later in the timeline when downloading them might cause a delay in playback.

• Lower the number of key frames and simplify the objects on the screen. Rapid scene
changes and high frame rates (rates greater than 7 fps) increase bandwidth and
processor requirements and dramatically impact presentation performance. To minimize
this impact, lower the number of key frames and simplify the objects on the screen  If
too much bandwidth is consumed, the player will pause the presentation and rebuffer.
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• Keep JPEG quality below 50 when exporting.  When exporting .fla files to .swf files,
the JPEG quality should be no greater than 50, possibly even as low as 30.
Experimenting with these values is strongly recommended as they also greatly impact
the bit rate of the .swf file.

• Put all movement into one local display area to minimize window redrawing. If
objects are localized to one area on the screen, RealPlayer has to redraw only the portion
of the window in which movement occurs.

• Do not front-load the presentation with high bit rate frames. Delay the introduction
of high bit rate sequences by inserting low bandwidth frames in the beginning of the
presentation. Display high bit rate sequences near the end.

Make your entire presentation work on low end PC machines

• Avoid using too many CPU intensive features at the same time. Flash's vector based
animation system differs from raster (bitmap) animation systems in that the host CPU is
required to perform calculations with the vector data before rendering the images on the
screen. Tweening multiple symbols in a frame, tweening color effects, changing large
areas of the screen between frames, and using gradient fills are all CPU intensive
operations requiring further calculations on top of the normal load RealFlash places on
the processor. Playback may slow down when too many CPU intensive features are in
use. Although some improvement in speed may occur when the file is exported to
Shockwave Flash format, results may vary with your design.

• Localize motion to one area. File size remains the same, but only one portion of the
screen needs to be redrawn.

• Turn off anti aliasing to minimize CPU usage

• • RealFlash content should be linear.  Branching is not recommended.

• Do not place actions in the first frame because they will not always work. This is an
anomaly of Flash.

• The amount of animation bandwidth available to a RealFlash developer depends on
which audio Codec is selected for the RealAudio track. As a result, it is important for
the RealFlash animator to determine before they start the animation process, which
Codec they are going to use.

Example:  If you choose the 6.5 audio Codec, you have 13.5 Kbps available for your
RealFlash animation, which translates into you having 1.68K per second available for
your RealFlash animation.
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Measuring the Presentation Bit Rate: The Movie Report

To determine the size of each frame of your animation, you can generate a size report when
you export your Flash file into Shockwave Flash. When the animation is exported, a text file
is created with the same name as the Flash file and is stored in the same directory. For
example, if your file is foo.swf, then foo.txt will be the name of the Movie Report file.

To generate a size report:

1. Export the Flash file (.fla) to an Shockwave Flash file (.swf)

2. Choose Generate Size Report in the Export dialog box.

3. Open Size Report in Word

4. Select the Frame Bytes column by holding down the Alt key and highlighting the Frame
Bytes column.

5. Go to the Edit menu and choose Copy.

6. Start Excel and open FlashTemplate.

7. Paste the data into the Bytes column.

 This enters the actual Frames Per Second and Delivery K Rate values into the Movie
Report.

Movie Report Example

Frame # Frame Bytes Total Bytes Page

1 1203 1203 Scene 1

2 2 1205 2

3 2 1207 3

Notice that Frame 1 is about 1K. It is small enough to load quickly so viewers don't have to
wait a long time to see something appear on the screen. Frame 2 is very small (2 bytes)
because it doesn’t need any more data to display it as it has everything it needs from Frame
1.

Open the Movie Report text file and look under the Frame # column to ensure that the value
in the ‘Frame Bytes’ column is less than 3000. Ideally, the bit rates at the beginning of the
presentation should be low (less than 3000) to allow for optimal streaming. If the ‘Frame
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Bytes’ value is greater than 3000, try to increase the time between scene changes to lower the
Frame Bytes value.

If you look at the Movie Report generated by Flash, the second column, titled ‘Frame Bytes’
tells you how many bytes each Flash frame consumes.

Note:  For more detailed information on your presentation bitrate, download the
“optimization kit” from the site you downloaded the RealFlash Content Creation Guide.

Total Bandwidth = Audio (Kbps) + Animation (Kbps)

20 = 5 + 15
20 = 6.5 + 13.5
20 = 8 + 12
20 = 8.5 + 11.5
20 = 12 + 8

Kilobits per second = bits per second = bytes per second
15 = 15000 = 1875
13.5 = 13500 = 1687
12 = 12000 = 1500
11.5 = 11500 = 1435
8 = 8000 = 1000

Note: 8 bits equals 1 byte
bytes per second = bits per second / 8 bits per second.

Optimizing Audio Files
• Use high quality source files.

• When possible, digitize the sound to a supported file format. Then pre-process the file
with a sound editing program. Set the amplitude of your input signal to maximize the
use of the available dynamic range.

• Eliminate any DC offset either while recording content or later with an audio editor.
This removes low frequency noise.

Use a CD-quality sampling rate (44.1 kHz), sampling width (16-bit), and two channels when
creating an input file that you intend to encode using multiple audio Codecs.

In general, we recommend:
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• 6.5 Kbps Codec for speech or for video-based content with speech and background
music (frequency response: 4khz). Using the 6.5 Kbps RealAudio Codec, leaves 13.5
Kbps available for a RealFlash file targeted to 28.8 Kbps modems.

• For music-based content, use the 8.5 Kbps Music Codec to translate the audio file to the
RealAudio format (frequency response: 4khz). The 8.5 Kbps RealAudio Codec leaves
12.0 Kbps available for a RealFlash file aimed at 28.8 Kbps transmission.

Audio files should have the following properties to ensure optimal audio quality when the
audio file is converted to RealAudio format:

Sample Rate: 22050 Hz

Channels: Mono

Resolution: 16-bit resolution

Please refer to http://www.real.com/help/content/audiohints.html for further tips on
encoding audio.


